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Basic Options

View tab Audiometry tab

Options File Menu

Options

Basic Options

View Live Speech
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REM MHA/HLS

Advanced Options
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Tympanometer Video Otoscope

 

 
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1. Test Selection Tool Bar 
2. Journal or Notepad 
3. Monitor Headset Control 
4. Ear Selection 
5. Output selectors 
6. Test Type Selectors 
7. Tone Type Selectors 
8. Output Level Potentiometers  
9. Masking Interrupter and Routing Selector 
10. No Response Button 
11. Patient Response Indicator 

 
 

 

12. Test Interrupter 
13. Back to the Main Screen 
14. Help 
15. Discard Current Measurement 
16. Talk Over 
17. Legend 

To exit the program, click on the “Back” button then click “Exit”. 
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 Spondee Word Lists A&B

 Start Test.

 

  Play

 

 

Correct

 

 Incorrect
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Audiometry 

 

  WR

 
 

 test ear

 
 

 Word List

 
 

 

 Start Test.

 

 Play

 

 

Correct

 

Incorrect 

  

Note that the score is calculated and displayed automatically. The test is complete when all words in the 
list have been presented.  The software automatically plots the score on the WR graph. 

Repeat test on opposite ear. 
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Performing the QuickSIN Test 

 

 

Audiometry

 

 QuickSIN

 

 
 

 

  list Select.

 

 
 

 

Play 

 

 

 

 check-box

 

 

Play
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After all six sentences are 
scored, the following 
results are displayed:

 

  

 

  Help  

 

 

 

 

 

 

 

 

 



20  D-0117971-B  01/2019 

 
 

 Tinnometer

The following screenshot shows the key features of the Tinnometer: 

 
 

 

 

 

 

 

 

 
 
 

Interactions with the patient are controlled as follows: 
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There are 3 Steps needed for Tinnitus Assessment with the Tinnometer 
 

 

 

 

Step 1: Identify Patient’s Tinnitus 
 

 
 

 

 tinnitus type

 
 

 
 

 start/stop toggle
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Step 2: Find Identified Tinnitus Threshold 
 

 

 down

2. Threshold Level  

Step 3: Masking Tinnitus for 60 Seconds 

 

 
 

 volume slider

 MML button

 

Tinnometer Modulation Tab 

 
The Tinnometer modulation tab is designed to simulate sound generators when 

hearing aid demonstrations cannot be performed. The following are controls 

used in Modulation. 
 

 
 

1. Type of modulation Sound 3. Frequency of modulation 
2. Speed of modulation 4. Modulation volume range 
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To use the Modulation features within Tinnometer, you must first complete the 

three steps involved with tinnitus assessment. Once tinnitus assessment is 
complete, you can use modulation by: 

 

 
 

1. Activating the channel in 

which the tinnitus 
assessment was 

performed. 

 
 

2. Enter the modulation tab 

on the right side of 
Tinnometer software. 

 
3. Adjust the modulation stimulus with sliders as a counseling tool for the 

patient. 
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Tinnometer Audiometry Scan 

 
The Tinnometer Scan tab is designed for various forms of air conduction 

audiometry. There are three types of audiometry that can be performed with 
Tinnometer. You can access the forms of audiometry with the buttons located 

by the number 1 in the image below. 
 

  
 
Tinnometer Residual Inhibition (RI) 

 
The Tinnometer RI tab is designed for Residual Inhibition (RI) testing for a 

patient’s tinnitus. The controls in the RI tab are as follows: 
 

 

1. Scale from 0-10 of 
tinnitus bothersome 

level 

2. Timer to begin 
stimulus 

3. Tracking of patient’s 
tinnitus bothersome 

level as a function of 
time 

 

A complete tinnitus assessment must be performed prior to performing testing 
in the RI tab. Once tinnitus assessment testing is completed, optional residual 

inhibition testing can be performed with the following steps: 

 

 

1. Activating the channel in 

which the tinnitus 
assessment was performed. 
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2. Select the RI tab on the 
right side of the Tinnometer 

software. 

 
 

3. Ask the patient the 

bothersome level of their 
tinnitus from 1 to 10 and 

mark their response. 

 
 

4. Click the stop watch to 
begin the masking stimulus 

(stimulus to play for 60 
seconds). 

 
5. Stimulus will play for 60 seconds and automatically stop at the 60 second 

point. 
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6. When the stimulus stops the patient must redefine their tinnitus 
bothersome level every 30 seconds. The bothersome level should 

decrease upon the stimulus stopping and will increase with time. 
  

7. The test continues until the bothersome level returns to pre-test level. 
 

Tinnometer Report Printing 
 

The Tinnometer has four reports available for printing: tinnitus assessment 
report, manufacturer guidance report, questionnaire report and a channel 

report. 
 

The following are common features found across reports: 
 

 
 

1. To generate your report, 

select “printer …” from 
the File menu. 

 
 

2. Select the paper style 

you are printing. 

 
 

3. Confirm all patient 
information is correct. 

 
 

4. Choose your print 
preferences. 

 
 

5. Change the zoom of your 

print preview. 

 

6. Print your Report. 
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Tinnitus Assessment Report 
 

Tinnitus assessment reports are able to be generated after completing the 
three steps to tinnitus assessment. Once all steps are complete you are able to 

print a report  
 

 
 

1. To generate your tinnitus 
assessment report, select 

“printer …” from the File menu. 

 
 

2. The “Channel” reports are the 

tinnitus assessment reports. 
Select the channel used for 

testing or All Channels when 
multi-channel testing is 

completed. 

 
 

3. Use the drop down box to 

select a diagnosis for the 
patient. 

 
 

 
 

4. Comments can be entered in 4 

separate lines with a maximum 
of 60 characters. 

 

5. Print the Report. 
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Manufacturer Guidance Report 

 
Manufacturer guidance reports are designed to provide hearing aid sound 

therapy guidance to a clinician based on tinnitus assessment results. Sound 
therapy is an option to tinnitus treatment. We encourage all clinics to develop 

a tinnitus treatment protocol that is in line with their tinnitus treatment goals. 
Manufacturer guidance generated by the Tinnometer is designed to be a 

starting point in sound therapy and each patient may differ in preferred sound. 
 

Manufacturer guidance reports are able to be generated after completing the 
three steps to tinnitus assessment. Once all three tinnitus assessment steps 

are complete you are able to print a report. 
 

 
 

1. Select the manufacturer that  
you would like to have printed 

in your report. 

 
 

2. To generate your tinnitus 
assessment report, select 

“printer …” from the File menu. 

 
 

3. Select “Hearing Aid Guidance” 
from the list of reports. 

 
 

4. Use the drop down box to 

select a diagnosis for the 
patient. 

 

 
 

5. Comments can be entered in 4 
separate lines with a maximum 

of 60 characters. 
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6. Print the report. 

 
Graph Channel Report 

 
Graph channel reports will print a patient report which displays an image of the 

patient’s tinnitus with QR codes for YouTube videos that play a wind 
modulation noise nearest to their tinnitus. To generate the report you must: 

 

 
 

1. To generate your tinnitus 

assessment report, select 
“printer …” from the File menu. 

 
 

2. Select “Graph Channel” from 
the list of reports.  Select the 

channel number which you 
used to match your patient’s 

tinnitus sound. 

 

3. Print the report. 

 

Questionnaire Report 
 

Questionnaire reports will only show as an option once the questionnaire has 
been completed. Once a questionnaire has been completed and you are ready 

to print a report you must: 
 

 
 

1. To generate your tinnitus 
assessment report, select 

“printer …” from the File menu. 
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2. Select the name of the 

questionnaire you want to print 
from the list of reports.  

 

3. Print the report. 

 

H L S

 HLS tab

 

 input signal type

 

 Normal 
Simulated

  Reset

 

 
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M H A

Binaural

Monaural

Live voice (microphone)

File 

CD 

Record 
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 Master Hearing Aid (MHA)

 

 File, CD, Mic, Record.

 Monaural Binaural.

 Normal 

 

track return

Reset 

.                                                            
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Tools > Calibrate 
Speakers. 

Start
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 
Probe Tube 
Calibration

 Tools.

 Calibrate 

Probe Tube.

Start

 

 

Function > Calibrate > Calibration
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Step-by-Step Guide to Live Speech Mapping 
 

Ensure the Audiogram is Entered 
 

 

 

 

 

 
 

 

 

Audio

 test ear

 Air.

 

 

 
 

Back

 LSM.

 LSM
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Speech Mapping with Live Voice Inputs 

 

 

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe).  It is also 
possible to underlay DSL IO or NAL-NL2 targets on this screen. Click Options in the text menu bar on 
the top of the screen to select and configure these underlays to meet the needs of your practice.
 

Speech Mapping with Recorded Inputs 
 

 

File

Start 

Stop

 

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also 
possible to underlay DSL IO or NAL-NL2 targets on this screen. Click Options + Show Targets in the 
text menu bar on the top of the screen to select and configure these underlays to meet the needs of your 
practice. 
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NOAH LSM

 

  

Completing the On-Top Mode Process  
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Unlike other products, the AVANT ARC system places full control over the measurement environment firmly 
in the hands of the hearing care professional. The system is powerful, yet extremely flexible, allowing each 
provider to use Live Speech Mapping in a way that compliments their practice style rather than 
compromising it. 
 

In order to get you “up and running” with the AVANT ARC system, MedRx has developed the following 
protocol. This simple procedure has been found to be effective with both audiologists and hearing instrument 
specialists. After mastering the basic operation of the system utilized in this protocol, you are encouraged to 
further expand your use of Live Speech Mapping in your practice. Feature-specific help is available by simply 
pressing the F1 key or clicking on the Help icon or text menu. 
     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
 

Probe Tube Insertion 
Guide 

for Live Speech Mapping 
and Conventional REM 

(re: Pomford, J & Sinclair, S. Real-Ear Measurement: 
Basic Terminology and Procedures. Audiology OnLine.com) 

 

 
     (Adult) 

 
    (Adult) 

 

 
 

1. Perform Otoscopic Examination 

2. Align end of Probe Tube with 

the 

left end of the appropriate 

guide 

3. Align tube marker with the red 

marker above 

4. Place Probe Tube in ear canal 

5. Confirm placement with 

Otoscope 

6. Perform Live Speech Mapping 

& REM 

 
 
 

 

 

 

 
 

 
 

 
 

 
 

 
 

 
 



D-0117971-B  01/2019 41                                                                                                            

 

 

 

 
 

 
 

 



42  D-0117971-B  01/2019 

 

 

 
 
 

 

 

 

 

 

 

 

 
 

 
 



D-0117971-B  01/2019 43                                                                                                            

Stimulus Signal Types 
 
Pure Tone 
 A pure sine wave. Crest Factor = 1.41 (3.0dB) 
  
Broadband Noise (BBN) 
 Uniform random noise with normal (Gaussian) amplitude distribution. Can be weighted to White, Pink, Speech ANSI, and Speech 
Byrne (see below.) 
  
Pseudo Random Noise (PRN) 
 A "synthetic" broadband random noise. It is less uniform than BBN, has lower spectral density and random volleys. Can be weigted to 
White, Pink, Speech ANSI, and Speech Byrne (see below.) 
  
ICRA Noise 
 This stimulus was developed for measuring characteristics of non-linear instruments. The noise is weighted to Byrne LTASS. 
  
ISTS 
(International Speech Test Signal) 
 Initiated by European Hearing Instrument Manufacturing Association (EHIMA.) This signal is based on natural recordings of 21 female 
speakers in six different languages - American English, Arabic, Chinese, French, German and Spanish. The signal is largely non-
intelligible because of segmentation and remixing. The speech material was filtered to Byrne LTASS. 
 
Crest Factor: 9.23 (19.3dB) 
 
  
Rainbow Passage 
 Natural recordings of several voices reciting the rainbow passage. Shaped to Byrne LTASS.  
 
  
Broadband Noise Weighting 
 
White 
 This is essentially no weighting or filtering. The White Noise has flat power spectral density. Power at every frequency is equal. 
Because the density of frequencies (individual cycles) raises with frequency, there is more energy in high octaves.  
White-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless 
specified by the manufacturer. 
 
Crest Factor: BBN = 1.73 (4.8dB), PRN = 7.86 (17.9dB) 
 
Pink 
 The noise is filtered so its energy per frequency (power spectral density) is inversely proportional to the frequency. Each octave carries 
the same amount of energy. Comparing to White Noise, the Pink Noise energy drops approximately 3dB per octave. 
Pink-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless specified 
by the manufacturer. 
 
Crest Factor: BBN = 3.67 (11.3dB), PRN = 6.55 (16.3dB) 

 
Speech - Byrne 
 The noise is approximately weighted to International Long Terms Average Speech Spectrum (ILTASS) as described in Byrne et. al., 
1994.  
The noise with this weighting is preferred for hearing aid fitting because its spectrum is the best approximation of the spectrum of real 
human speech. 
 
Crest Factor: BBN = 4.22 (12.5dB), PRN = 3.47 (10.8dB) 

 
Speech - ANSI 
 The noise is approximately weighted to ANSI S3.42 Speech Noise. 
The noise with this weighting can be used for fitting hearing aids. The slope of ANSI-weighted noise is not as steep as Byrne-weighted, 
so there is more power in higher octaves.  This will result in less gain required by the hearing aid to reach targets, but may result in 
under-fitting at high frequencies. 
 
Crest Factor: BBN = 4.46 (13.0dB), PRN = 5.17 (14.3dB) 
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To activate specific REM tests, click the buttons as follows: 
 
 

 

Opens the audiometry data entry screen.  Use this if audiometry has not been previously 
measured and entered into NOAH. 

 

Allows the selection of fitting rules to generate targets.  The following rules are supported: 
½ Gain, POGO I, POGO II, Berger, 1/3 Gain, NAL-RP, FIG6, DSL, NAL-NL1. 

 

Real Ear Unaided Response - Measures the additive effect of the ear canal’s resonance 
to a stimulus.  Reported as dB SPL of output. 

 

Real Ear Unaided Gain - Measures the additive effect of the ear canal’s resonance to a 
stimulus.  Reported as dB SPL of gain.  If a real ear unaided response (REUR) curve has 
been measured, the corresponding real ear unaided gain curve is automatically plotted to 
the REUG screen. 

 

The difference between the REUG and the REAG is called the Real Ear Insertion Gain 
(REIG). This Insertion Gain information is used to compare to the target gain curve 
selected for the client. 

 

The Real Ear Aided Response (REAR) is the sound pressure level in the ear canal 
measured with the probe microphone close to the eardrum and the operating hearing 
instrument inserted in the ear and turned on. ANSI defines REAR as the SPL, as a 
function of frequency, at a specified measurement point in the ear canal for a specified 
sound field, with the hearing aid in place and turned on. 

 

The REAG is simply the REAR expressed as gain rather than SPL. Selecting REAG 
allows you to see the gain at each frequency for each of the REAR curves measured. 

 

REOR measures the effect on the natural external ear effects resulting from inserting an 
ear mold or a hearing instrument, before it is turned on, into the ear canal. The REOR is 
also referred to as Insertion Loss. REOR is also useful for validating the effectiveness of 
venting or canal length changes to the mold.  

 

The Real Ear Occluded Gain (REOG) is the difference in decibels, as a function of 
frequency, between SPL in the ear canal and SPL at the reference microphone at the 
entrance of the ear canal with the hearing aid in the ear and turned off. For each REOR 
measurement curve, the corresponding REOG curve is calculated and automatically 
plotted to the REOG screen. The REOG function is useful in determining the acoustic seal 
of a hearing aid, relative to a sound field outside the ear. 

 

Some clients report they seem like they are “speaking in a barrel” or “feel blocked up”. 
These are signs of a build up of self generated low frequency energy in the ear canal. This 
excessive occlusion can be measured objectively in the Occlusion Effect task. 

 

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by 
coupler measurements and is useful when fitting children or “difficult” to fit patients.  See 
the section on RECD later in this manual for more detail. 
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Real Ear to Coupler Difference (RECD) 
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How to perform the RECD task 

REAR with a hearing instrument
 

 

 

 

 

 

REAR with an insert headphone
 

 

 

 
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Coupler Response 

 

 

 

 START

 

 Coupler Response Stored 

 OK

 

 

 

 

 

 

 



48  D-0117971-B  01/2019 

 

 

 

 

 

 

 Start button.

5. 

 

 

Options 

1/24 octave.
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 or SN 

 

 

 
 

 

 

Read the instruction 
manuals for safe usage of 

the device  
(operating instructions) 

 Indicates that the device 
serial number will follow 

 

 Type B applied part.  (Type B 
equipment) 

 Manufacturer 
(MedRx) 

 Authorized 
Representative in 

Europe 

 

 

 

 

 

 

 

 

 

Non-ionizing 
electromagnetic radiation 

 Special Disposal Required  Humidity Limitation  Caution, General 
warning sign 

 Temperature 
limitation 

 

 

 

 

 

 

 

 

 

Read the instruction 
manuals for safe usage of 

the device  
(operating instructions) 

 Class II equipment  Start (of action)  Stop (of action)  Percentile Setup 

 

 

 

 

 

 

 

 

 

Calibration  Loudspeaker (Speaker)  Headphones  Microphone  Recording 

 

        

CAUTION 
For Single Patient Use 

Only 

      

 

  

 

 The date of manufacture is shown on the original calibration certificate. The year of manufacture is 
shown in the fourth character in the serial number. M=2014, N=2015, P=2016, Q=2017 etc. 
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